
 

 

 

 

 
 
 
 
 
 

 
 
 
 
 

Centralized monitoring software 
 
 
 

 
 

(version v2.35) 
Program installation and configuration 

 
 
 
 



 

TRIKDIS 
Monas MS v2.35_IM_EN_161223 

2 
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1 The purpose of Monas MS  

Program Monas MS is an applicable program package for display, processing and storage of messages received 
by centralized security and monitoring stations.  
 

1.1 Computer and network requirements 

Program package Monas MS may be installed in one computer or in several computers connected to a single 
network. In order to install Monas MS v2.35 computer must meet the following minimum requirements. 
 

Operating system 

32 bit (for 2000 - 5000 objects) 64 bit (for > 5000 objects) 

Processor frequency:  ≥2 GHz Processor:  Intel I7 or better 

Memory:  2-4 GB RAM Memory:  6 GB RAM 

Hard drive:  100 GB of free space Hard drive:  100 GB of free space 

Database:  150 GB of free space Database :  500 GB of free space (20 000 
objects ≈7 GB/month) 

Windows XP, Win 7 and upper Win7 and upper 
Windows Server 2008 
Hardware Raid (several parallel discs) 

Note: 
Computer parameters may be lower if a separate Monas MS client workplace is being installed in a 
network. Meeting OS Win XP installation requirements is sufficient. 

 
To use the program in a monitoring station the following must be foreseen: 

1) Adequate number of serial ports RS232 in the computer to which Monas MS server is being installed to 
connect required equipment. The use of USB or other artifices is not recommended.  If necessary, use ports 
that are inserted into the computer motherboard; 
2) Color display monitors: at least 21", 1920x1080 resolution; 
3) At least one audio speaker for audio signals; 
4) Standby power supply source to ensure continuous monitoring station operation for at least 1-2 hours. 

 
Computer in an Ethernet network: 
Computers must operate in a single network in order to install Monas MS in several workplaces. 

1) Network speed should be sufficient for handling massive data traffic (not less than 10 Mbit/sec.). If 

necessary, create a separate centralized monitoring station subnetwork and block unauthorised access into 

its operation; 

2) An external connection to the server must be secured, router configured and necessary ports 

forwarded if electronic Google map is used; 

3) An external connection to car's Garmin navigation using connection equipment A1 TRAX must be 

secured, router configured and necessary ports forwarded if connection with fast reaction group is used; 

4) An external connection to operator's SMS center must be secured, router configured and necessary 

ports forwarded or a local SMS modem with chosen operator's SIM card set up if SMS communication with 

the clients is carried out; 
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5) The program should be installed on a computer with OS Win7 or newer with enabled IIS (Internet 

Information Service) v7+ and ASP.NET setting, router configured so that data flow via port 3800 is directed 

to a computer with installed Monas MS WEB if remote WEB workplace will be installed and used; 

Recommended network structure for Monas MS installation is displayed in the picture below. Two separate 
subnetworks (station and office) are projected in order to avoid unauthorised access into the operation of the 
monitoring station.  

 
 
All data receiving equipment is connected to the computer with installed Monas MS server. Monas MS server 
and database can be installed on the same computer. Powerful servers may be used for big stations (projected 
tens of thousands of secured objects). It is recommended to store and save data in a separate backup server. It 
is advisable to install Monas MS client administrator workplace in the same computer for convenient 
connection. 
Other Monas MS client workplaces should be installed to separate computers depending on tasks to be 
performed in the station. 

2 Program installation 

Note:  

DotNet Framework 4.0 must be installed, that Monas Ms would work properly. Usually win8 and upper versions 
already have this program.  

Main software suite is comprised of database Monas.Net Database working in MS SQL Server 2008 R2 
database management system and programs Monas MS server and Monas MS client. Secure access USB key is 
used to  set program operation parameters. Sentinel driver is necessary to ensure its functioning. These 
programs are installed in the order listed below: 

1) Database Monas.Database; 

2) Monas MS server; 

3) Monas MS client; 

4) Sentinel driver; 

Station icon appears on the desktop after Monas MS server is finished. This part of the program is necessary to 
determine the port for connection with mobile crews when NAV program module is used. 
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Program module Monas MS WEB is installed additionally in order to ensure remote installer connection to the 
program.  

All other program options are indicated in the secure access key and do not require additional program 
installation. 

Note: 

Real computer IP address (local 127.0.0.1 or external, e.g.  192.168.X.X) is indicated when Monas MS is being 
installed on one computer.  

Firstly, network is configured and IP addresses of the devices are set when the program is being installed on a 
network. Real computer IP addresses are indicated during program installation and configuration. 

2.1 Database installation 

Note:  

It is very important to set your region parameters, before database installation (in control panel – clock, 
language, region): 

1. Location 
2. Language for non-unicode programs 
3. Date separator "." (2016.01.01 arba 01.01.2016) 

1. Open subdirectory Database in Monas MS v2.35 install directory. Double-click on the program installation 
file setup.exe. 
 

 
 
3. InstallShield Wizard window will open. Click Install. 

 

             
 
Note: 
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Do not close the operating system window when it pops up now or at a later stage. Wait until it closes by itself. 
It might take several minutes. 

 
4. A prompt message asking to reboot the computer will pop up. Click Yes. 
 

 
 
5. Database installation wizard window will open after the reboot. Click Next. 
 

 
 
6. Database user information window will open. Click Next. 
 

              
 

7. Database server window will open. Click Next and then click Install. 
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Note: 

Specify the location for database installation if installation error is displayed. Different computers have 
differently named directories.  

In order to do so: 
1. Specify the database. Click Browse... and select a different location for installation.  
If installation does not start, select Server authentication using the Login ID and password below, specify the 
Login ID - sa and password – root. Click Next. 
 

                  
 
2. A prompt asking to reboot the computer will pop up. Click Yes.  

 

 
 
3.  Computer will restart and installation process will continue automatically. Installation progress in 

displayed in Database installation window. 
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4. Click Finish to finish the installation process. 
 

2.2 Monas MS server installation  

1. Open subdirectory v2.35 in Monas MS v2.35 install directory. Double-click on the program installation file  
Monas MS server setup.exe . 

 
 

2. InstallShield Wizard window will open. Click Install. 
 

           
 
3. Do not close the operating system window when it pops up. Wait until it closes by itself. It might take 

several minutes. 
4. Monas MS server installation wizard window will open. Click Next. 
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5. Monas MS server user information window will open. Click Next. 
 

             
 
6. Monas MS server installation destination window will open. Click Next. Click Change to choose a different 

installation location. 

 
 

7. Click Install. 
8. Installation progress is displayed in Monas MS server installation window. 
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9. Click Finish to finish the installation process. 
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2.2.1 If Monas MS server was installed manually 

 
If Monas MS server was installed manually, use steps below configure SQL:  
1. Open SQL Server Configuration Manager; 
2. Switch to the SQL Server Network Configuration | Protocols for SQLEXPRESS; 
3. Double-click the TCP/IP protocol; 
4. Select the Yes value in the Enabled field; 
5. Switch to the IP Addresses tab;  
6. Find the ipall section; 
7. Clear the TCP Dynamic Ports field in that section; 
8. Specify the 1433 value in the TCP Port field; 
9. Restart your server and try to connect to your server using just its IP address. 

 
 
Note:  

More information how to connect from another computer see:  
https://technet.microsoft.com/en-us/library/ms345343(v=sql.110).aspx 
And three ports must be opened:  

1. SQL port (default 1433); 
2. Monas MS port (default 8766); 
3. Time synchronization port (37). 

 
 
 
 
 
 
 
 
 
 

https://technet.microsoft.com/en-us/library/ms345343(v=sql.110).aspx
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2.3 Monas MS client installation 

Note:  

Please ensure that you are installing Monas MS client version consisted with Monas MS server version. 

 
1. Monas MS client can be installed on any computer in a network. Open subdirectory v2.35 in Monas MS 

v2.35 install directory. Double-click on the program installation file Monas MS client setup.exe . 
 

 
 

2. InstallShield Wizard window will open. Click Install. 
 

 
 

3. Monas MS client installation wizard window will open. Click Next. 
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4. Monas MS client user information window will open. Click Next. 

 

 
 

5. Monas MS client installation destination window will open. Click Next. Click Change to choose a 
different installation location. 

 

 
 

6. Click Install. 
7. Installation progress is displayed in Monas MS client installation window. 
8. Click Finish to finish Monas MS client installation process. 

 
 

2.4 Security key driver installation. 

Monas MS program options are indicated in secure access USB key. 
DEMO version of the program able to support two workplaces and description and monitoring of up to 30 
objects will run if access key is not used (or not inserted). SMS, MAPS, NAV and WEB program modules may not 
be used. 
Access key is inserted into the computer USB port with installed Monas MS server. Sentinel driver must be 
installed on the computer. 
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1. Open subdirectory Sentinel in Monas MS v2.35 install directory. Double-click on the driver installation 
file SentinelProtectionInstaller. 

 

 
 

2. Program installation wizard window will open. Click Next. 
 

 
 

3. Select I accept the terms in the license agreement and click Next. 
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4. Select Complete and click Next. 
 

 
 

5. Click Install. 
 

 
 

6. When the note window opens, click Yes. 
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7. Installation progress is displayed in the program installation window. 

8. Click Finish to finish the installation process. 
 
Monas MS icons displayed on the desktop: 

 to open  Monas MS server and the database; 

 to open  Monas MS client; 

 to set NAV connection port of the  program module; 
 

2.5 Monas MS WEB installation. 

IIS (Internet Information Service) v7 with ASP.NET setting must be enabled and router configured so that data 
flow via port 3800 is directed to this computer before installing Monas MS WEB. 
In order to do so: 
1. Open Control Panel and select Programs and Features (in OS Win7). 
 

 
 



 

TRIKDIS 
Monas MS v2.35_IM_EN_161223 

17 

 
 
2. In a new window click on Turn Windows features on or off and select Internet Information Services. 

 

               
 
3. Click OK. 
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4. Settings can be checked using the command Control Panel → Administrative Tool → IIS Manager → Help 
→ About IIS (to check IIS version) and Control Panel → Administrative Tool → IIS Manager → Export Server 
Package (to check whether options are ticked). 

 
5. Open subdirectory v2.35 in Monas MS v2.35 install directory after OS parameters are set. Double-click on 

the installation file Monas MS WEB. 
6. Click Install. 
 

 
 

 
7. A new window will open. Click Next. 
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8. Monas MS WEB installation destination window will open. Click Next. Click Change to choose a different 

installation location. 
 

 
 
9. Monas MS WEB installation window Database Server will open. Click Browse... and put database 

connection information. 
10. Click Next. 
 

 
11. A new window will open. Click Install. 
12. Installation progress is displayed in Monas MS WEB installation window. 
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13. Click Finish to finish Monas MS WEB installation process. 

3 Starting and closing the program 

Monas MS should be started in accordance to the procedure laid down: program Monas MS server is started 
first, then – Monas MS Client programs. Program Monas MS server might be set to start automatically upon 
computer startup during the installation process. In such case, Monas MS client may be started upon computer 
startup. 
Program is closed in reversed order: all Monas MS client programs are closed first to be followed by Monas MS 
server. 
 

3.1 Starting Monas MS for the first time 

Double-click on Monas MS server desktop icon . A prompt asking to select the program language will pop 
up. Select the language and click Select Language. 
 

 
 

 
Note: 
If you wish error reports to be sent to program developers click Yes. 

 
Windows Firewall window will open. Allow Monas MS server to share data with other programs. Select Domain 
networks, such as a workplace network (or specify the network) and click Allow access. 
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Database Connection window will open. Select destination address ...(local)\SQLEXPRESS, in the box User put in 
root and in Password – put in root. If a different destination address is used, put in sa in the box User and root 
in the box Password. Click Save and Connect. 
 

                   
 
A prompt asking to update the database may pop up if the database version is different from the version used 
by Monas MS server. Click OK.  
 

               
 
Progress is displayed in the installation window.  
 
Active program icon will appear in the taskbar. Move the mouse on the active program icon. Right-click on it to 
reveal options Show/Stop. Select Show. A new window will open. Put in the short program administrator name 
and the password.   
 

 

Short name [1] and password [adm]. 
Click OK. Main Monas MS server program window will open. 

It is important that server and database are running. Start parameters are displayed in the status bar at the 
bottom of the main window.  
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If server is not running, select the command Connections → Server → Set Port and put in the IP address (Server 
IP) and used port (Server Port) of the computer with installed Monas MS server. 
 

 
Note: 
Address 127.0.0.1 is used when the program works in only one computer, external IP address is used in all other 
cases. Port 8760.  
Another port may be chosen. It is important that the same port is specified in both server and client programs. 

 
Open the server by using the command Connections → Server → Start Server. 
 
Use command Connections → Database to connect to a database or to select a different one. A new window 
will open. Select the database specified during the installation, put in the user name and the password. 
 

                    
 
Select the working language of Monas MS server. Prompt the language selection window by using the 
command Configuration → General Parameters, select the desired language and click Set. 
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Close Monas MS server using the command File →Close.  
 

 
 
Click Yes. 
 
Insert the access key into the USB port of the computer with installed Monas MS server. 
Start Monas MS server as described above. 
 
 
Notes: 
1. Note DEMO will disappear and options selected in access key will be activated once access key is 

inserted and Monas MS server restarted. 

2. A prompt asking to update the database may pop up if the database version is different from the 

version used by Monas MS server. Click Yes. 

 

 
 
Double-click on Monas MS client icon. In a new window specify the IP address of the computer with installed 
Monas MS server. Click OK. 
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Note: 

IP address should be specified according to the configuration of the computer network.  

 

A new window will open. Put in the short program administrator name and the password. 
 

 

 

Factory settings: 
short name – [administrator] and password [admin]. 
or 
short name - [1] and password [adm]. 
 
 
Click OK. Main Monas MS client program window will open. 

 

 
 

It is important that server and database are running. Start parameters are displayed in the status bar at the 
bottom of the window. If the database is not running, it can be started using the command Configuration → 
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Database. A new window will open. Specify the used database, and put in the user name and the password 
used for database.  
Note:  
As address not only domain name can be used, but also SQL database full IP address. 

 

 

Factory settings: 
user - [root] and password [root] 
or 
user - [sa] and password [root] 
 
Click Save and Connect to open the database. 

 
Select the working language of Monas MS client. If you want to change the working language, use the 
command Configuration → Options → General Parameters, select the desired language and click Set. 
 

 
 
Restart Monas MS client. Language settings will have changed.  
 

3.2 Starting Monas MS server the next time 

Double-click on the icon. Active program icon will appear in the taskbar and Monas MS server will start. Start 
Monas MS client if program settings do not have to be changed. 
If Monas MS server program settings need to be changed, move the mouse on the active program icon. Right-
click to reveal option Show/Stop. Select Show. A new window will open. Put in the short administrator name 
and the password. 
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Factory settings: 
short name - [1] and password [adm]. 
 
 
Click OK. Main Monas MS server program window will open. 

 

 
 
It is important that server and database are running. Start parameters are displayed in the status bar at the 
bottom of the main window. If server is not running, open it by using the command Connections → Server → 
Start Server. 
 

 
 

3.3 Starting Monas MS client the next time 

This program can be installed either on the same computer as the server or on a different one. 

Double-click on the icon. A new window will open. Put in the short program user name and the password. 

 

 
 
Factory settings: 
short name - [1] and password [adm]. 
 
 
Click OK. Main Monas MS client program window will open. 
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In is important that server and database are running. Start parameters are displayed in the status bar at the 
bottom of the main window. If the database is not running, it can be started by using the command 
Configuration → Database. A new window will open. Select the database in use, put in the user name and the 
password.  
 

 

 
 
Factory settings: 
user - [root] and password [root]. 
 
 
Click Save and Connect and the database will start.  

 
 

3.4 Closing Monas MS client 

Program is closed using the command File → Close.  
 

  Click Yes to close the program. 
 

3.5 Closing Monas MS server 

Move the mouse on the active program icon. Right-click to reveal option Show/Stop. Select Stop.  
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Click Yes and program will close. 
 
If nothing happens after selecting Stop, select Show. A new window will open. Put in the short program 
administrator name and the password. Try to close the program again.  
 
 

4 Monas MS server configuration 

Program configuration is carried out once Monas MS server is started in order to ensure the correct interaction 
between the parts of the program.  
 

 
 
Database and server configuration and connection 
It is important that server and database are running. Start parameters are displayed in the status bar at the 
bottom of the main window. Detailed start process is described in section “Starting Monas MS for the first 
time“.  
If database is not running, it can be started by using the command Configuration → Database.  
If Monas MS server is not running, it can be started by using the command Connections → Server → Start 
Server. Command Connections → Server → Set Port will open the window that displays Monas MS server 
installation IP address and port. 
 

 
Note: 
Addresses specified in the picture are most commonly used when Monas MS is installed on one computer.  

 
Same actions are performed when Monas MS is to be installed on several computers working in one network. 
Real IP addresses of network devices are specified.  
 
 

4.1 Connection and configuration of data receivers 

Messages from receivers are received via consistent COM (RS232) ports or through the local network using TCP 
protocol. The latter option must be activated using the secure access key. 
Open the port window using the command Configuration → COM Ports and specify parameters of the 
necessary COM (RS232) ports. Click New to enter a new port, Change to change its parameters, Delete to 
delete a port from the list and Clean to clear messages stored in that port. 
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In the window Change port specify the name of the receiver, the protocol used for connection with the 
computer, select a port and its settings, enter the lines, specify their types and names and select Follow 
Receiver.  
Please note the protocol used by the receiver for connection with a computer and the port settings. Program 
allows using different protocols for separate ports. Enter all lines.  
Select Radio Line if the connection between the receiver and the computer is carried out in Surgard MLR2-DG 
protocol and radio security system RAS-2M messages are being transmitted. This will allow the display of the 
events in the screen correctly. Phone Line is selected in all other cases. 
In specific cases messages received through one line have to be forwarded to another one by changing the line 
number. It can be done by choosing the desired line, ticking Forward to and indicating the number of that line. 
Received messages will be displayed in the screen under another line number. 
 

 
 

Note: 
Information on possible message forwarding to other devices is laid out in other documents. 

 
Connection with receiving devices may be checked by following the command Data → COM port data. Choose 
the desired port. Messages received via that port and data exchange will be displayed in real time.  

 
Open the settings window using the command Connections → Receive TCP protocol if messages are received 
using the TCP protocol. In the settings window specify the IP address and the port of the device the data is 
received from, select Open and Follow Receiver. 
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5 Creation and segmentation of automatic database backup schedule 

5.1 Schedule creation 

Database backup schedule is created by using the command Configuration → Database in program Monas MS 
server. 
 

 
 
Information on when and how often databases are created (object slips, current and last month messages) and 
where they are stored is displayed in tab Full backup. Copies may be stored in several locations. File limit is also 
specified. 
Select when the first database copy will be created in the box Start time. 

Select the frequency and periodicity of how often database copies will be created in the boxes Backup period, 

Month, Day, Hour. Time is shown according to the set periodicity, that is, the next copy creation date will be 

later than now (time is reset upon reopening the Backup copy window) in the box Start time. 

The number of the latest copies to be stored in the specified directories and the older ones to be deleted is set 

in the box File limit. 0 means that all data copies will be stored.  

Locations for storing created database copies are shown in the box Backup directories. Database copies may be 

stored in several locations.  
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Because a not archived database file can not be very large when database copies are created, the location of a 

directory where temporary files are stored is specified in the box File to store temporary files. Temporary files 

are deleted once a database copy is created. 

 

Received event files are displayed in tab Previous months. 
 

 
 

Created database copies have an extension .mnr and their names YYYYMMDD_HH:mm:ss.mnr refer to the date 

and time when the file was created. All data in relation to the objects and event descriptions, received and 

processed events, archived (processed) events of the current month, archived events of the last month and 

settings of the ports used by Monas MS server are stored in the file. 

Click Make backup to create a selected month events database copy and save into a data logger. Copied files 

will have an extension .mnb. 

Monthly data can be deleted from the SQL server in order to clear up the space and save resources.  Click 

Remove to delete events in a selected month (it is recommended to make a copy prior to this). Deleted data 

will not be available in Reports. 

Old events that are deleted from the database can be uploaded and rewatched if their copy is on the disc 

(extension .mnb).  Click Import events and select the desired .mnb file to upload the events. Uploaded events 

can be found in Reports. Response comments are uploaded together with the events. 

5.2 Segmentation of received messages 

Automatic segmentation of received messages is carried out in order to reduce the database space and make 
the creation of reports faster, therefore, messages older than two months are moved to separate databases 
stored in different files. Segmentation is carried out on the first half of the first day of the month. If necessary, 
segmented messages can be stored in both, a database and in a separate data logger. Segmented messages in 
the database can be used for creating reports, or those stored in a data logger for restoring a failed database. 
Databases of event segmented last month are displayed in window Previous months. Event segmentation is 

carried out on the last day of every month at 23:59:59, all messages received that month are moved to a new 

database. 

For example:  
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October events will be segmented and moved to a separate database on the 30th of November at 23:59:59. A 

note 2011 10 will be displayed in this table on the 1st of December at 00:00:00 (depending on the length of 

segmentation, time may be 00:00:15). Months displayed in this window refer to the available data for report 

creation.  

6 Monas MS client configuration 

6.1 Key controls 

Monas MS client is controlled by using menu bar commands or/and keyboard shortcuts.  
Command File → Log out… allows one operator to finish the shift and the other to start one.  
Command File → Clear… deletes messages from the top processed messages window. 
Command File → Users… is used to set program user access and options.  
Command File → Close is used to close Monas MS client. 
Command Data → is used for creating databases on secured objects. 
Command Configuration → Options is used to set desired main window properties. 
Command Configuration → Archive is used to move data from received messages window to processed 
messages window.  
Command Configuration → Unlock is used when moving received messages to processed messages window is 
not allowed.  
Command Configuration → Shortcuts is used to create a key combination for a selected action from the list. 
 

 
 
Choose the action and press a desired key combination on the keyboard. 
Select the desired combination and click Enter in order to delete it. 
 
Commands Configuration → Database and Configuration → TCP server allows to change the database and 
server addresses. These commands are used when the existing network configuration is being changed or new 
workplaces are installed.  
Command Configuration → Receiver time setting is used to set the time on radio receiver RI-4010VT which 
works using Monas2 protocol. 
Command Reports → is used to create event reports.  
Command Help → About displays brief information on the program version: name of the program, version, 
date of creation, developers and main functions. 
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6.2 Setting main window properties 

Properties of the main window of Monas MS client are set by using the command Configuration → Options. 
Choose the working language in tab General Parameters. 
Specify the information that will be seen once a new message arrives (left tab) concerning active events in the 
window (mid tab) and on processed events (right tab) in tab Main Window Configuration. 
 

 
 
Tick Clear to disable the display of events in the top window on the program startup. 
Box Next event refers to time after which a new message window will be opened. 
Tick Hide screen to close the message window. If ticked, message window is minimised and operation sees the 
entire width of the screen once there are no processed messages. If unticked, an empty message window 
taking up half of the screen will be displayed.  
Set the number of messages to be displayed on the screen in the box See in window… Other messages can be 
checked using the report properties.  
 
Some message codes and responses are displayed in tab Event Parameters. Settings of this tab normally are 
not changed.  
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Tick Unknown Object – React to display all received objects (including not described ones) on the screen. Untick 
to display only described objects.  
Some program responses and used message codes can be changed in this tab. 
 
Sound properties, color indications and notes of the monitoring schedule are set in tab Main screen sounds and 
colors. 
 

 
 
Set the time after which a signal will be heard following a received message in the box Sound starts after. It is 
recommended to set it to 0 sec. Signal intervals can be set in the window Sound delay interval. 
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Select the signal for new events, its intervals and the melody in the section New events sound. It is 
recommended to keep the factory settings.  
Colours and notes of the monitoring status and starting and closing schedules can be set in the section Object 
status color. 

7 Setting monitoring properties 

Properties of Monas MS client responses can be set using the command Configuration → Options. 
Event codes that will be formed when secured object status is changed to special or back or when unimportant 
events are entered are set in the tab Object parameters. 
Tick the formation of desired messages and specify the even codes. Recommended event codes are presented 
in the table below. 
 

 
 

Event description Event code Note 

Object status 
(secured/not secured/special security) 

E B01 000 
Message is formed once the monitoring 
status is changed.  

Temporarily unimportant events: 
upon activation 
upon restoration 

 
E B02 000 
R B02 000 

Messages are formed once object event 
monitoring is changed. 

Object comment E B03 000 
Message is formed when a new object 
comment is entered.  

Waiting for restoration E B04 000 
Message is formed if event restoration 
message is not received within the time 
period specified in the object comment.  

Note: 
Messages are formed using the receiver and line codes displayed in this table.   

 
Event codes used in the object comments need to be described. 
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Set the automatic update of the objects list using the setting List refreshing. If ticked and the time period is 
specified, list of the objects in the tab List of the main Monas MS client window will be updated periodically. 
Click Refresh to update the list manually.  

8 Setting crew and object monitoring properties 

These sections are displayed and filled in only if program modules MAPS and NAV are used. 
Possible responses, fast message texts and other control parameters are set in the tab Drivers. 
Possible reaction statuses are set in the box Driver status list, possible station operator's responses and 
directions in the box Custom responses. 
Set possible crew responses in the box Quick messages. 
 

 
 
Setting Generate comment after moving (Started to move) indicates the distance from the starting point that 
the crew has to make in order to record the moving and form the note Started to move. 
Setting Generate comment when distance between driver and object is (Arrived at object) indicated the 
distance to meters between the car and the object in order to record the arrival at the object and form the 
note Arrived at object.  
Setting Default driver reaction time defines the crew response time. A more detailed description on the crew 
response times can be found in the object comment section Driver reaction time. Value of this setting is used if 
there are no entries in the indicated section. 
Some moving and showing settings can be set in the tab Map. Event codes that will be formed once the mobile 
crew enters the set ground area can be found in the same tab. 
Choose the map showing mode. If box Separate window is ticked, the map will be opened in a separate 
window and lists of the objects will be in the main one.  
Set the view scale between 1 and 21. 1 means that the view will be from far away (high), 21 – very close. It is a 
Google Maps parameter. Crew scale is used when a crew is selected in the map, object scale when the object is 
selected. 
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Specify the event codes. Recommended event codes are shown in the table below. Codes are applied to all 
crews. Once crew returns to the deployment location an event with a comment including crew IMEI and/or its 
name is formed. 
 

Event description Event code Note 

Crew left the zone E B05 000  

Crew returned to the zone R B05 000  

Crew did not return in time E BF3 000  

Event in Aplicom input   

upon activation E BF4  

upon restoration R BF4  

Note: 
Object number is not used in the program.  

 
 

9 Database backup and backup copy upload 

Database stores data in relation to objects and event descriptions, received messages and Monas MS server 
port settings.  
It will not be difficult to ensure fast program operation restoration in the event of a computer failure or when 
installing new equipment if automatic database copy schedule is created and copies are stored in a data logger. 
This section describes how to create a database copy manually and how to transfer available data into a new 
database. 
 

9.1 Database backup 

Database backup is performed using database creation/restoration program Database backup which can be 
found by following Start Menu → Programs → Trikdis → Monas MS server. 
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1. Once Database backup is running it can be chosen whether to create a database copy (Backup) or to 

restore the database from a copy (Restore).  

 

 
 

Select Backup or Restore and click OK. Put in MS SQL server login details.  
 

 
 

2. Click OK and select location for the backup file.  

 

 
 

3.  Click Finish to create a database copy.  

Backup progress is displayed in the new window. 
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4. Once database backup is finished, file with an extension .mnr and name YYYYMMDD_HH:mm:ss.mnr will 

be created. File will contain this data: all data in relation to objects and event descriptions received and 

processed messages, last month events and Monas MS server port settings. 

9.2 Backup copy upload 

5. Choose Restore and click OK. Select a data copy file to be uploaded. Only files (with extension .mnr) 

created using Database Backup program or Monas MS server database copy module may be selected. 

Note: 
Monas MS server and Monas MS client programs must be closed during the data upload.  

 

 
 

6. Click Next. A message will pop up warning that the present data will overwrite existing Monas MS 

database. Click Finish to save. 
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Note: 
A message might appear during the upload warning that Monas MS server installation was not found and COM 
port settings will not be uploaded. Upload will continue upon clicking OK, however, COM port settings file will 
not be uploaded. 

 
 

7. Upload progress is displayed in the new window. 

 

 
 

8. Once data backup is finished click Close. 

 
 
 


